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I. Introduction 
 

I-1. Overview 
 

This manual provides step-by-step instructions for the use of UV Lab software with a Lambda 

465 Spectrophotometer.  

UV Lab software must be installed onto a Microsoft® Windows 7, Windows 8 or windows 10 

operating system to function properly. 

 
The following icons are used throughout this manual to emphasize important information. 

 
▣     General explanation about the main subject 

▶     Detailed or expanded explanations about the main subject 

    Message contains important information about procedure or technique 

◇?E A   Message contains helpful supplementary information  
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I-2. Specifications of UV Lab  
 

Operating Environment 

Support PDA UV-Vis Spectrophotometer 

 

∙ Lambda 465 UV-Visible Spectrophotometer 

Control Accessories 

∙ 8 Cell Water Jacketed Cell Changer  
∙ Water Jacketed Automatic Referencing Stage  
∙ Auto Sipper System  
∙ Single Peltier Temp ctrl Unit L465 
∙ Multi Peltier Temp ctrl Unit L465 
∙ Reflectance Holder 
∙ Autosampler  
∙ DRA-100 
. Magnetic Stirrer Assembly (Auto Type) 
. Magnetic Stirrer Assembly (Manual Type) 
. Rapid Mixing Accessory  

Minimum Computer Requirements 

Processor : Intel® Core 1.5 GHz or faster 
RAM : At least 1GB  
Hard disk : 50GB with 1GB free 
Input devices : Mouse and keyboard 
Monitor : 1024x768 (minimum) 
Media : CD ROM Drive 
Port : USB port for the data acquisition 

Operating System 

∙ Microsoft® Windows 7 or Windows 8 or Windows 10 
∙ If using UV Lab  Security Software : Microsoft® Windows 7 Professional, Ultimate, Enterprise, 

Windows 8, Windows 10 

Output Device 

∙ Microsoft® Windows compatible printer 
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UV Lab Software 
- Instrument Control, Data Acquisition and Standard Experiments 

General Mode 

Wavelength 
Monitoring 

∙ The full spectrum (190 ~ 1100 nm) of each sample is extracted at once 

Equation 
Calculation 

∙ Allows the user to enter support equations for the evaluation of the data  
∙ Supports Functions: +, - , /, *, ABS, Exp, LN, LOG10, SQRT 

Find/Peak Valley ∙ Find up to 30 of the peaks or valleys automatically or manually 

Quantification Mode 

Quantification 
Standard/Sample 

∙ Concentration Unit: All units user-specifiable  
∙ First, second and third order calibration curve fits 
∙ Supports zero offset of calibration curve  
∙ Calculation of correlation coefficient 

Thickness Mode  

Thickness 
Measurement 

. Measure the thickness of thin film using the Reflectance Holder 

Kinetics Mode 

Time Based 
Kinetics 
 
 
 
 

∙ 3D Display: Time Display(X Axis), Zoom In/Zoom Out, Rotate Chart 
∙ Full Spectrum 
∙ Time Unit: Min, Sec, Msec 
∙ Zero Order, Initial Rate, First Order, Delta Au 
∙ Data from single wavelength (using the multi-cell) or multiple wavelengths 
(using the single cell) can be extracted for the rate calculation 

Temperature 
Based 
Kinetics 

 

∙ 3D Display: Time Display(X Axis), Zoom In/Zoom Out, Rotate Chart 

∙ Temperature Unit: ℃ 

∙ Temperature Limit: from -10℃ to 100℃ 

UV Lab Ultra Kinetics Software (Optional) 

Ultra Kinetics 
 

∙ Time Unit: Msec 
∙ Minimum Interval Time: 20 msec 



 
 

4  UV Lab’s Software User Guide                                         PerkinElmer 

UV Lab Bio Analysis (Optional) 

Bio Mode 

Nucleic Acid 
Analysis 
 

 

 

∙ General Ratio with two wavelengths for the calculation of user specified 
ratios. 

∙ Determine concentration of protein and nucleic acid using coefficients 
∙ Baseline Correction  
 

Protein Analysis 
 
 
 
 
 
 
 
 
 

 

∙ Predefined methods  
∙ Bradford Protein Analysis at 595 nm  
∙Bicinchoninate (BCA) at 562 nm  
∙Biuret Protein Analysis at 540 nm  
∙Lowry Protein Analysis high sensitivity at 750 nm  
∙Lowry Protein Analysis low sensitivity at 500 nm  
∙Lowry Protein Analysis at 740 nm 
∙Trinitrobenzene Sulfonate at 416 nm   
∙Direct UV at 280 nm  
∙Direct UV at 205 nm 

 

Cell Density 
 

∙ Predefined methods  
∙ Cell Density calculated with absorbance of 600 nm 

Enzyme Activity 
 
 
 

 

∙ User Specifies One Activity Factor 
∙ Data from single wavelength (using the multi-cell) or multiple wavelengths 
(using the single cell) can be extracted for the rate calculation 

∙ Baseline Correction 
 

Enzyme 
Mechanism 
 
 
 

 

∙ Michaelis-Menten 
∙ Lineweaver-Burk 
∙ Hanes-Woolf 
∙ Eadie-Hofstee 
∙ Calculate Km, Vmax from each plot 
 

Thermal 
Denaturation 
 
 
 

 

 

∙ Temperature Unit: ℃ 

∙ Temperature limit: from -10oC to 100oC 
∙ Tm calculated with average method & 1st Derivative 
∙ Volume correction with user specified equation 
∙ Normalization with user specified factor 
∙ User defined equation allows calculation from Tm value (ex: %G-C) 
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Color Analysis Software (Optional) 

Color Analysis Mode 

Color Analysis 
 

 

. Color Difference Formula Function 

. Measure the various Color Indices  

. This can be added to any of UV Lab Software upon request. 

  

Multi-Component Analysis Software (Optional) 

Multi-Component Analysis (MCA) Mode 

Multi-Component 
Analysis (MCA) 
 
 

∙ Analyze complex compounds containing multiple components (up to 4 
components) 

∙ Define the concentration of each component 
.This can be added to any of UV Lab Software upon request. 

  

System Performance Validation Software (Optional) 

Validation 

Validation 
 
 

 

∙ Automatic Validation Wizard assists with the validation across the UV and 
Visible range 

∙ Includes Photometric, Wavelength, Resolution, Stray Light, Stability and  
Dark Current tests 

  

UV Lab Security Software (Optional) 

UV Lab Security Software 

Provides enhanced security with Windows 7 Professional, Enterprise, Ultimate, Windows 8, 
Windows 10 Operating Systems to assist with 21 CFR Part 11 compliance requirements for 
electronic signatures and electronic record traceability. This software package is supplied with the 
UV Lab Security Software Manual. 
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I-3. UV Lab Software Interface 
 
▣ This chapter describes the unique display features of UV Lab Software. 

 
 

I-3-1. Window Title 
 
▣ Display the title of an active window or file. If data is saved as a specific file, its name will 

become the window title; otherwise, the title will be assigned automatically as [Untitled-1], 

[Untitled- 2], etc. 

 
 

I-3-2. Main Menu 
 
▣ The Main Menu consists of a File Menu, Edit Menu, Measure Menu, View Menu, Math Menu, 

Window Menu and Help Menu. 

  

   Window Title Main Menu Lamp On/Off Trace Bar 

Spectrum Radar 

View Bar 

Tool Bar 

Experiment Information 

Main Window 

Result Window 

Spectrum List & Comment 

Spectral Display Function Tool 
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I-3-3. Toolbar 
 
▣ The toolbar provides quick access to basic commands without opening a menu. Users can 

modify the configuration of the toolbars as desired. 

Icon Command Hot Key Icon Command Hot Key 

 New Ctrl + N  Contents F1 

 Open Ctrl + O  Blank Alt + B 

 Save Ctrl + S  Sample Alt + S 

 Print Ctrl + P  Stop  

 Cut Ctrl + X  Absorbance Alt + A 

 Copy Ctrl + C  Transmittance Alt + T 

 Paste Ctrl + V  Reflectance Alt + R 

 Delete Del  Energy Alt + I 

 Undo Ctrl + Z    

▶ See II. File Menu, III. Edit Menu and IV. Measure Menu for more details. 
 
 

I-3-4. View Bar 
 
▣ There are four types of modes in the UV Lab software that can be selected by the user to 

analyze samples and manipulate collected data. 

Mode Functions 
 

Wave Scan 
 
 
 
 
 
 

 

Wavelength Monitoring 
Equation Calculation 
Find Peak/ Valley 
Thickness Measurement  
Color Analysis (Optional) 
Multi-Component Analysis (MCA) (Optional) 

 

Quantification 
 

 

Quantification Standard 
Quantification Sample 

Kinetics 
 
 
 

Time Based Kinetics 
Temperature Based Kinetics 
Ultra Kinetics (Optional) 
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Mode Functions 

 

Bio Analysis  
(Optional) 
 
 
 
 

 

Nucleic Acid Analysis 
Protein Analysis 
Cell Density 
Enzyme Activity 
Enzyme Mechanism  
Thermal Denaturation 

 

 

I-3-5. Main Window & Spectral Display Function Tool 
 
▣ Display the spectral data. If there are several spectra in the window, only an active red 

spectrum can be edited. 

▣ Display the spectrum window and calibration curve in the quantification experiment, or the 3D 

spectrum and 2D spectrum in kinetics and bio experiments. 

▣ Display a main window as required. 

The following table provides a brief description of each Display Function Tool. 

Toolbar Command Description 

 Zoom In Zoom in the selected area 

 Zoom Reset Reset the zoom area to the original size 

 Y Axis Auto Scale Allow the auto scale of Y-axis depending on the 
measurement result 

 Pick Peak Look for peaks. Use in Peak/Valley Mode 

 Pick Valley Look for valleys. Use in Peak/Valley Mode 

 Cursor Display the cross lines for selecting data points 

 To Left Move the cursor to the left 

 To Right Move the cursor to the right 

 View 3D graphic mode May be used in Kinetics & some Bio Modes 

 Add Label Add label on the spectrum. 

 Edit Label Edit label on the spectrum. 
  

 
 

 

Properties 
 

Display Interval, Change a chart (background & 
axis) color, legend display, grid, X-axis and Y-axis 
scale, and decimal point format, etc. 

▶ See VIII. Display Function Tools for more details. 
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▣ Display the optional function when you click right mouse in the main window. 

   i) Copy is useful when you paste into another program such as Microsoft Excel or other 

windows programs. 

ii) Pop up chart is useful when you confirm that selected spectrum. 

      
 

 
 

I-3-6. Result window 
 
▣ Display result values of performed measurements. 

▣ Copy and paste into another program such as Microsoft Excel or other windows programs when 

you click right mouse in the result window. 

 
 
 

I-3-7. Trace bar 
 
▣ Display X-axis and Y-axis values of the mouse pointer on the spectrum. 

 
 

 

I-3-8. Lamp ON/OFF 
 

▣ Switch the lamp ON/OFF. 

▣ Procedure 
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1. Followings are the status of the lamp. 

 

▶ The left icon means the Deuterium lamp (UV lamp). 

▶ The right icon means the Tungsten lamp (Visible lamp). 

 
2. If you want to turn off the UV lamp, click UV ON. The following dialog box will be displayed. 

Select OK. 

  

 
3. Then the UV lamp will be turned off and the icon will be changed as shown below. 

 

 
4. If you want to turn on the UV lamp, click UV OFF. The following dialog box will be displayed. 

Select OK. 

 

▶ The UV lamp requires 30 seconds to be turned on completely after clicking OK. 

 
5. Then the UV lamp will be turned on. 

 

 

I-3-9. Spectrum Radar 
 

▣ Display the specified range of spectrum. In the Time Based Kinetics, Enzyme Activity, Enzyme 

Mechanism modes, the overlay of all spectra is displayed in the Spectrum Radar window during 

the entire measurement. 
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 Because of the limitation of memory, the Spectrum Radar window can display only up to  

500 spectra. 

1. By clicking the Range Set  button, the X axis(wavelength) and Y axis 

(A, %T, %R and I) range are set. 

2. Allow the auto scale of Y-axis (A, %T, %R and I) by clicking the Y Auto  button  

3. By clicking the Reset  button, reset the Y-axis to the original size.  

 

 

I-3-10. Spectrum List & Comment 
 

▣ Display the Name, Date, Mode, Scan No. and Integration No. of spectrum in the main window. 

▣ Procedure 

a. Spectrum List. 

1. Change a spectrum name by clicking it. 
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2. Enter a new name. 

 
 

b. Spectrum Comment 

1. Select the sample to comment in the spectrum list.  

 
 

2. Enter a comment by selecting a spectrum, typing a comment and clicking Enter. You can 
check spectrum comment at the print. 
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I-3-11. Experiment Setup  
 

▣ Display and modify the experimental setup of Method, Accessory Type, Mode, Spectra No., 

Scan No. and Integration No. 
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Parameter Function 

Method See V. Experiment Method for more details. 

Accessory Type 
 

Choose an accessory.  
Refer to each accessory manual for more details. 

Baseline Correction Choose Baseline Correction Yes or No. 
See V-1-1. Wavelength Monitoring for more details 

Mode 
 

Fast, Faster, Fastest and User defined Values may also be set for 
each mode. See IV-4-1. Mode for more details. 

Spectra No. See V-1-1. Wavelength Monitoring for more details. 

Scan No. See V-1-1. Wavelength Monitoring for more details. 

Integration No. See V-1-1. Wavelength Monitoring for more details. 
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II. File Menu 
 

▣ The File menu includes commands to perform general file functions as shown in the following 

table. 

 

 
 
 
 
 
 
 

II-1. New  
 

▣ Use the New command to open a new window. 

▣ Procedure 

1. Select New to open a new window.  
  

  

 
2. Enter a Title and Comment (if desired), Sample Name (if desired) and select the 

Command Function 

New 

Open 

Close 

Close All 

Open a new window 

Open saved data 

Close the current window 

Close all windows 

Save 

Save As 

Save data  

Save data using a new file name 

Open Method 

Save Method 

Open a saved method 

Save a method  

Export Export data to another program 

Print Print results  

Exit Exit UV Lab Software 
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Experiment Type. If you do not enter a title, the title will be assigned automatically as 

[Untitled-1], [Untitled-2].....And if you do not enter a sample name, the sample name will 

be assigned automatically as [Sample 1], [Sample 2]…. 

 
3. Click OK. 

 

 

II-2. Open  
 
▣ Use the Open command to open data in a file. 

▣ Procedure 

1. Select a file to open, the title, date, comment, experiment type and spectrum is 

displayed. 

 
2. Select Open. 

 
3. The selected files can be displayed in a new window by clicking Open in New Window 

at the bottom of the box. 
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The following file type options are available: 

File Type Description 

All Files (*.*) 

UV Lab All Files 

 

UV Lab Wave Scan Files (*.gdt) 

 

UV Lab Quantification Files (*.qdt) 

UV Lab Kinetics data Files (*.kdt) 

 

UV Lab Bio Files (*.bdt) 

UV Lab Color Target Files (*.sdt) 

UV Lab Color Standard Files (*.agdt) 

UV Lab MCA Standard Files (*.mgdt) 

UV Lab Thickness Files (*.rdt) 

UV Lab Ultra Kinetics data Files (*.akt) 

All kinds of files 

All kinds of UV Lab files (*.gdt, *.qdt, *.kdt, 

*.bdt, *.rdt, *.sdt, *.mgdt, *.akt) 

Wave Scan / Color Mode Sample/ MCA Mode 

Sample data  

Quantification Experiment data 

Time Based Kinetics & Temperature Based 

Kinetics data 

Bio Mode Experiment data 

Color Mode Target data  

Color Mode Standard data  

MCA Mode Standard data 

Thickness Mode data 

Ultra Kinetics data 

 
 

II-3. Close 
 
▣ Use the Close command to close a window. 

▣ Verify the data was saved before closing the window. 

 
 

II-4. Close All 
 
▣ Use the Close All command to close all windows. 

 
 

II-5. Save 
 
▣ Use the Save command to save the data in the current window. 

▣ Procedure 

1. To save data, select a folder to save data in, enter a file name, and select Save. 
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Please refer to II-2 Open for file types. 

 
 

II-6. Save As 
 
▣ Use the Save As command to save data using a new file name. 

▣ Procedure 

1. To save data with a new file name, select a folder to save the file in, enter a file name and 
click Save. 

 
Refer to II-2. Open for file types. 

 
 

II-7. Open Method 
 
▣ Use the Open Method command to open a method stored in a file. 

▣ Procedure  

1. To open a method, select a file to open and select Open. 
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II-8. Save method 
 

▣ Use the Save Method command to save the current setting for the data collection and 

processing methods. 

▣ Procedure 

1. To save a method, enter a file name and select Save. 

  

 
2. Method file extensions are automatically assigned as *.mtd. 

 
 

II-9. Export 
 
▣ Use the Export command to export the data to another program such as Microsoft Excel, or 

other Windows programs. 

▣ Procedure 

1. Click Export. Choose the desired format type, as shown, and select OK. 
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File Type Description 

Export Sample Spectrum 

Clipboard(Copy) 

CSV Format File 

 

 

 

Only Selected 

CSV Format File (Raw data) 

JCAMP (*.dx) Format File (only last selected) 

ASCII (*.asc) Format File (only last selected) 

Bitmap(BMP) Format File 

Window Meta File(WMF) Format File 

 
Export 3D Spectrum 

Clipboard(Copy) 

Bitmap Format File 

Window Meta File Format File 

 
Export Result Data 

Clipboard(Copy) 

Microsoft Excel Format File 

 

Copy the spectrum as the picture 

Export a spectrum as a *.csv file. The interval 

between wavelengths is determined by the 

sampling interval. See VIII-4. Display 

Function Tools for more details. 

Cehck: Export an only selected data. 

Export an original spectrum as *.csv file 

Export an original spectrum as *.dx file 

Export an original spectrum as *.asc file 

Export a spectrum as *. bmp file 

Export a spectrum as *.wmf file 

 
 

Copy the 3D spectrum as the picture 

Export a 3D spectrum as *.bmp file 

Export a 3D spectrum as *.wmf file 

 
 

Copy the result data 

Export the result data as MS Excel format file 
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II-10. Print   
 

▣ Use the Print command to print or preview data in the current window. 

▣ Procedure 

1. The following print-preview window will be displayed. 

 
2. Select the required print contents and select Print. 

  
 

Function Description 

Pre Page 

Next Page 

Zoon In 

Zoom Out 

 

Pre Page allows you to go back to the previous page 

Next Page allows you to go to the next page 

Zoom In allow you to maximize the window 

Zoom Out allows you to revert the maximized the window to 

the standard size 

 

NOTE: User can change the company logo. 

a. Click Open Logo.  

b. Select the desired company logo. The selectable logo file is *.bmp file and the 

recommended size is 110x50 pixels. 

c. Check the company logo is changed. 

 

II-11. Exit 
 
▣ Use the Exit command to close UV Lab Software. 
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III. Edit Menu 
 

▣ The Edit Menu includes commands to perform spectrum functions as shown in the following 

table. 

  
 
 
 
 
 
 
 
 
 
 
 

 
 
III-1. Undo             

 

▣ Use the Undo command to undo a previous edit operation. 

▣ Procedure 

1. To undo an edit, click Undo in the Edit menu. 
 

 
 

III-2. Cut     
 

▣ Use the Cut command to remove the selected spectra and place the cut items on the clipboard.  

▣ Procedure 

1. Select a spectrum to cut. 

Command Function 

Undo Undo the previous edit operation 

Cut Spectrum 

Copy Spectrum 

Paste Spectrum 

Delete Spectrum 

Delete All 

Remove the spectrum from a window 

Copy the spectrum in a window 

Paste the spectrum into a window 

Delete the spectrum from a window 

Delete all spectra from a window 

Select All Select all the spectra in a window 
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2. Select Cut in the Edit menu. If there are several spectra in the window, click Spectrum 

List to choose a particular spectrum to cut. 

 
3. Place the cut spectrum in another location using the Paste command. 

 
 

III-3. Copy 
 
▣ Use the Copy command to duplicate the selected items onto the clipboard.  

▣ Procedure 

1. Select a spectrum to copy and click Copy in the Edit menu. 

 
2. Paste the copy into another location using the Paste command. 

 
 

III-4. Paste 
 
▣ Use the Paste command to place a cut or copied item in the desired location. 

▣ Procedure 

1. Cut or copy a spectrum to paste into a window. 

 
2. Select Paste in the selected window. Copies of the same item can continue to be pasted 

until another item is cut or copied.  

 
 

III-5. Delete 
 
▣ Use the Delete command to delete the selected spectrum from the active spectrum window. 

▣ Procedure 

1. Select a spectrum to delete or click Select All to delete all spectra in the window. 

 
2. Click Delete. 

 

III-6. Select All 
 
▣ Use the Select All command to select all spectra in the active spectral window. 

▣ Procedure 

1. To select all, click Select All.  
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IV. Measure Menu 

 

▣ The Measure menu includes commands to perform measurement and diagnostic functions as 
shown in the following table. 

 

  
 
 
 
 
 

IV-1. Run Blank 
 
▣ Use the Blank command to collect a new blank spectrum. 

▣ Procedure 

1. Place a blank in the sample holder. 

 
2. Select Blank. 

Measure a new blank spectrum each time parameters for an experiment are changed. 

 

IV-2. Run Sample 
 
▣ Use the Sample command to measure a sample. 

▣ Procedure 

1. Place a sample in the sample holder. 

 
2. Select Sample.  

This icon is activated after a blank is measured.  

 

Command Function 

Run Blank 

Run Sample 

Collect a blank spectrum 

Collect a sample spectrum 

Method Set the mode and data collection 
parameters  

Validation Verify instrument performs 

Options 
Select measurement conditions 
[Mode, Instrument settings, etc.] 

Instrument Check electronic and optical components  
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IV-3. Method 
 
▣ Use the Method command to set modes and parameters to control data collection. 

▣ Procedure 

1. Select File menu. 

 
2. Select New. Select Experiment Type. 

 

 
3. Click OK. See V. Experiment Method for more details. 

 

4. The following method window is displayed. Set each parameter and click OK. 

 

5. Open or save a method using the  and  icons. The method will be saved as a 

*.mtd file. 

 

IV-4. Options 
 
▣ Use the Options command to select the measurement and instrument settings, and for 

automatic interface setup. 
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IV-4-1. Mode  

 
1. Set customized parameters for each mode by entering a value in each box as shown and 

click OK. Default settings are shown below. Refer to V-1-1. Wavelength Monitoring 

for more details. 

 
 

 

IV-4-2. Others 
 
      Use automatic function to save, smooth and correct data automatically. Select the  

functions to apply and select OK. 

 

▶ If Automatic Save is checked: 

1. An [AutoSave] folder is created under the UV Lab folder.  

2. Acquired data is saved in the AutoSave > untitle-#(Date, Time) folder automatically 

as sample name .csv and date.time.csv.  
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3. Acquired data is saved in AutoSave > PEData folder as *.bak file. If the extension is 

changed from ‘*.bak’ to the extension of UV Lab files, e.g. *.gdt etc., you can open 

this backup file from UV Lab software. 

▶ Automatic Smoothing: Smoothes data automatically. In Automatic Smoothing, the 

Window Size and Polynomial Degree set is adjustable. Refer to VII-1. Smoothing for 

more details. 

▶ Automatic Anomaly Correction: Corrects anomaly peaks automatically.  

▶ View Replicated Samples and Average in Quantification: Refer to V-2. 

Quantification Mode for more details. 

▶ Show Message of Replicate Number in Quantification: Refer to V-2. 

Quantification Mode for more details. 

 
 

IV-4-3. Instrument Setting 
 

▣ Use instrument setting to setup the interface and peristaltic pump when necessary. Select OK 

when finished.  

▣ As to the Peristaltic Pump Setup, refer to Auto Sipper manual. 

 
 

IV-4-3. Path 
 

▣ Use Path to designate the default data or method folder. Select OK when finished.  
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IV-5. Instrument 
 

▣ The Self Diagnostics functions are important for ensuring optimum performance of the system. 

▣ All electronic and optical parts of the system are automatically checked at startup, or on 

demand, to ensure the instrument is performing to specification. 

 
 

IV-5-1. Simple Diagnostics  
 
▣ Simple Diagnostics provides a limited set of diagnostics tests. 

▣ Simple Diagnostics list 

General  

Shutter & Filter Speed measurement 
Check Dark Current 
Lamp Intensity evaluation 
Check Wavelength 
Check Noise level 

 

▣ Procedure 

1. To perform a Simple Diagnostics test, select Simple Diagnostics in the Measure menu. 

 
 

2. Select Start. 
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3. The following dialog box shows the status of the Simple Diagnostics. 

 
 

4. Simple Diagnostics is finished. 

 
 

5. Select View Result to view test result. 

 

 

6. Select Print or Save to print or save the results are required. The results of the Simple 

Diagnostics test are saved as month-day-year (hour-min)-S.dgs in the Diag folder of 

UV Lab folder. 
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7. To open a saved result, select Simple Diagnostics in the Measure menu. Click Open. 

 

 

8. Select the desired file and click OK. 
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IV-5-2. Advanced Diagnostics  
 

▣ Advanced Diagnostics provides a complete set of diagnostics tests. 

▣ Advanced Diagnostics list 

General  

Shutter & Filter Speed measurement 
Check Cooling Fan 
Check Dark Current  
Lamp Intensity evaluation 
Check Wavelength  
Check Noise & Power 

Lamp 
Check Lamp On/Off and Power 
Indicating consumed life time of the Lamps and Time to Replace 

Accessories 
Check cell positions of the 8 Cell Water jacketed Cell Changer or 
ARS(Water Jacketed Automatic Referencing Stage) 

▣ Procedure 

1. To perform an Advanced Diagnostics test, select Advanced Diagnostics in the 

Measure menu. 
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2. Select tests to run and click Start. 

 
 

3. When tests are complete, click Print or Save to print or save the results as required. The 

results of the Advanced Diagnostics test are saved as month-day-year 

(hour-min)-A.dgs in the Diag folder.  
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4. To open a saved result, select Advanced Diagnostics in the Measure menu and select 

Open. 

 

 

5. Select the desired file and click OK. 
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V. Experiment Method  
 

V-1. General Method 
 

▣ This mode includes the following Experiment types: 

• Wavelength Monitoring 

• Equation Calculation 

• Find Peak/valley  

• Thickness  

• Color Analysis (Optional) 

• Multi-Component Analysis (MCA) (Optional) 

▣ Method parameters in this mode can be modified after a measurement is complete. For 

example, users can modify the parameters of a Find Peak/Valley method after the 

measurement is complete and monitor their effect on the results.  

▣ Results in this mode are interchangeable. For example, data measured using  

Equation Calculation method can be opened in a Wavelength Monitoring method. 

▣ Perform a General Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure blank. 

4. Measure samples. 

5. Save or print results as required.  

 

V-1-1. Wavelength Monitoring Mode 
 
▣ Use Wavelength Monitoring to collect data over the full spectral range of the instrument, or a 

specified interval. Perform this type of experiment.  

▣ Procedure 

1. Select New. 

 
2. Select Wavelength Monitoring in Experiment Type. The method dialog box will be 

displayed. 
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3. Setup the Experiment Setup parameters as follows: 

a. Data Type: Select the units of the Y-axis. Absorbance, Transmittance or Reflectance. 
b. Sampling: Select a sampling accessory. 

c. Mode: Select test mode (Fast, Faster, Fastest) with fixed parameters for Spectra No., 

         Scan No. and Integration No. or select User Defined to customize parameters.  

d. Spectra No.: Determines how many times the sample is measured. 

 e. Scan No.: Determines how many scans are performed during a data collection. 

If the scan number is greater than one, the system averages all the collected data from all 

or the scans. This increases signal-to-noise ratio and total collection time. In general 

cases, we recommend setting this parameter to “30”.  

 f. Integration No.: Determine the length of time a sample is exposed to the light source. 

A high integration number increases the signal-to-noise ratio.  

 Integration No vs Integration Time 

Integration time(ms) = 20.48 x Scan No x (integration NO + Default integration NO) 

  The integration number needs to be chosen carefully so as not to saturate 
the spectrum.  

 ◇?E A What is Saturation? 

 When the integration number is too big, portions of the spectrum can be cut off because 
the detector reaches its maximum detection limit of light. This makes the difference 
between blank and sample data meaningless. The maximum value of Y axis should not 
exceed “60000” count. 
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4. Click Baseline Correction and set the baseline correction parameters. 

 
▶ Refer to the next page for more details.  

 
5. Click Monitoring Wavelength and then the following dialog box will be displayed. 

  

 
6. Enter the wavelengths to be monitored using Insert or Delete and click OK. 

 
7. After completing parameter setup for Experiment Setup, Baseline Correction and 

Wavelength Monitoring, click OK. 
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8. Measure the blank. 

 
9. Measure the samples. 

 
10. Save or print spectrum and results as desired. 

▶ To Edit a sample name, double click the sample line to be changed in the list. 

 

 

◇?E A Baseline Correction 

Baseline Correction is a technique that can be used to improve the precision of results by 
minimizing the effects of any changes that cause a linear baseline shift, for example, a 
drift in lamp intensity. This technique is particularly useful for samples with low 
absorbance. The value is calculated by method suited to each condition. Result spectrum 
is presented that eliminates baseline values from the absorbance. 
There are three methods of calculating the baseline values. 
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▶ Single Point 

   Use when the baseline shift is the same at all wavelengths. A reference wavelength 
on the baseline is selected. Baseline value is eliminated by subtracting the absorbance 
at the reference wavelength from the absorbance of the full wavelength. 

Aλ

ARλ

0

λ λR

fλ

Spectrum

Result spectrum

Aλ

ARλ

0

λ λR

fλ

Spectrum

Result spectrum

 

fλ = Aλ - ARλfλ = Aλ - ARλ
 

 
fλ is the function result at wavelength λ 

 Aλ is the absorbance at wavelength λ 
 ARλ is the absorbance at reference wavelength λR 

 
▶ Range Average 

   An extension of the single point method, it is used when it is difficult to select a 
reference wavelength as a point. The reference wavelength replaces the single 
wavelength absorbance value with the average absorbance value over a wavelength 
range. 
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▶ Three Points 

   Use to correct a slant baseline. The absorbance values from the two reference 
wavelengths, AR1 and AR2, define a straight line, which is used to calculate the 
reference absorbance(ARλ) at the wavelength(λ). Resulting spectrum are calculated 
using the following equation. 

Spectrum

Result 

spectrum

fλ

Aλ

AR1

ARλ

AR2

λR1 λ λR2

Spectrum

Result 

spectrum

fλ

Aλ

AR1

ARλ

AR2

λR1 λ λR2  

ARλ =
λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝ARλ =

λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝ARλ =

λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝

 

 

 fλ is the function result at wavelength λ 
 Aλ is the absorbance at wavelength λ 
 ARλ is the reference absorbance at wavelength Rλ 

 

 

V-1-2. Equation Calculation Mode 
 
▣ Use Equation Calculation to collect data for a calculated result using a specified equation. 

▣ Procedure 

1. Select New. 

 
2. Select Equation Calculation in Experiment Type. The method dialog box is displayed.  
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3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 

 
4. Click Equation Calculation and set parameters as follows.  

a. Equation Name: Enter the equation name. 

 b. Equation Unit: Enter the units of the Y-axis. Absorbance, transmittance or 

reflectance. 

 
5. Click Equation Expression The following dialog box will be displayed. 

 
 

6. Enter the wavelengths, which will be monitored using Insert and Delete. 
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7. Enter the equation to apply to the data using the calculator keys and click OK. 

Key Function 
Wavelength 

 

+ 

- 

/ 

* 

ABS 

EXP 

LN 

LOG10 

SQRT 

Use the absorbance result at the selected wavelength. 

Equation can contain up to nine. 

Add 

Subtract 

Divide 

Multiply 

Calculate the absolute value 

Calculate e(exp) 

Calculate the Natural logarithm  

Calculate the common logarithm  

Calculate the square root 

 
8. After setting parameters for Experiment Setup, Baseline Correction and Equation 

Calculation, select OK in the method setup window. 

 
9. Measure the blank. 

 
10. Measure the sample. 

 
11. Save or print the data and spectra as required.  

V-1-3. Find Peak/Valley Mode 
 
▣ Use Find Peak/Valley to determine the maxima and minima of Y-values in the defined 

wavelength range of the spectrum. 

 
▣ Procedure 

1. Select New. 
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2. Select Find Peak/Valley in the Experiment Type. The method dialog box is displayed. 

 
 

3. Setup experiment and baseline correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 
 
4. Setup peak/valley parameters. 

a. Automatic Find: Select Yes or No for the automatic location of peaks and valleys. 

b. Absorbance Threshold (AU): Enter an absorbance value for the threshold. Peaks 

about this threshold are included in the result window.  

c. Transmittance Threshold (%): Enter a transmittance value for the threshold. Peaks 

about this threshold are included in the result window. 

d. Intensity Threshold (cnt.): Enter an intensity value for the threshold. Peaks about 

this threshold are included in the result window. 

e. Find Peak: Select Yes or No for finding peaks. 

f. Peak No.: Select the number of peaks to find. 

g. Find Valley: Select Yes or No for finding valleys. 

h. Valley No.: Select the number of valleys to find. 

i. Start Range (nm): Enter the start wavelength for the desired range to search. 

j. End Range (nm): Enter the end wavelength for the desired range to search. 

 
5. After setting parameters for Experiment Setup, Baseline Correction and Find Peak/Valley, 

click OK. 

 
6. Measure the blank. 
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7. Measure samples. Peaks and valleys are found automatically.  

 
8. For manual peak finding, use the following icons to pick peaks and valleys or seek data. 

Select Pick Peak/Valley icon. See VIII-3. Pick Peak/Valley for more details.  

 Pick Peak     Pick Valley 

 These icons are not activated if Automatic Find is specified. 
 

9. Save or print data and spectra as required. 

 

 

V-1-4. Thickness Mode 
 

▣ Use Thickness Mode to measure the thickness of a film. 

▣ The Reflectance accessory is required to perform reflectance measurements in this mode. 

▣ Procedure 

1. Select New. 

 
2. Select Thickness in the Experiment Type. The following window is displayed. 

 
3. Click Parameter Setting as follows. 

a. Data Type: Choose Reflectance or Transmittance. 

b. Scan No.: This parameter determines how many scans are performed during a data  

collection. If a number of greater than one is specified, the collected data is averaged. 
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This increases the signal-to-noise ratio and also the total collection time. 

c. Integration No.: This parameter determines the length of time a sample is exposed to  

Light source. A high integration number increases the signal-to-noise ratio. However,  

you must control the integration time carefully so as not to saturate the spectrum. 

d. Reflective index of thin film (n): Enter the known value for the coating material of 

the thin film. 

e. Start Wavelength (nm): Enter the start wavelength for the measurement. 

f. End Wavelength (nm): Enter the end wavelength for the measurement. 

g. Incident Angle (Degree): 34 ° (fixed for Reflectance Accessory) 

h. Manual Number of Wave (M.N.W): The required fringe (wave) numbers are used to 

calculate the thickness between start wavelength and end wavelength. M.N.W. can be 

modified after the measurement is complete. 

ⅰ. 0: Automatic fringes (wave) are detected and counted automatically. The software 

identifies the valleys closest to the user entered Start Wavelength and End 

Wavelength values, counts the number of fringes (wave) between them, and 

calculates the thickness. 

ⅱ. If the software can not locate the appropriate fringe (wave) shapes and locations, 

set a value more than 2 in the Manual Number of Wave box. See point 9, below.  

  
4. Click OK. 
 
5. Load the reference material on the sampling port and measure a blank spectrum. 
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6. Load a sample on the sampling port and measure sample spectrum. 

  
 

7. Film thickness calculations are performed automatically using the following equation. 

 

 

 

Where:  d = film thickness 

w = number of fringes (waves) between λ1 and λ2 

n = reflective index of thin film 

θ = Angle of incidence 

λ1 & λ2 = peak wavelengths (nm)  

 
8. Zoom in this extracted spectrum to see start and end wave positions precisely. In this 

example, the start wave is 237.9 nm and the end wave is 790.1 nm. 
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9. In some cases, the software may not find the peak because the wave of the spectrum is 

too small. In this case, thickness can be calculated manually. 

 Click Experimental Setup and zoom in on the area of the wave in the spectrum.  

a. Count the number of waves and define the start and end wavelength.  

b. To compare the manual result with the result of an automatic calculation of thickness, 

enter the value of the start wavelength (237.9 nm) and end wavelength (790.1 nm) 

and click OK. 

 

 
c. The result of the manual thickness calculation is shown. In this example, the 

thickness calculated is 1.06031 um and is the same as the automatic thickness 

calculation. 
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V-1-5. Color Analysis Mode (Optional) 
 
▣ Use Color Analysis to measure Color Scale values including CIE color (L*, a*, b*) and Hunter 

(Lab). The test can be used for: 

• Quality Control of the color difference 

• Variable Color Indices 

• Confirming a Yxy chromaticity diagram.  

▣ Procedure 

1. Select New. 
 

2. Select Color Analysis in the Experiment Type. The method dialog box is displayed.  

  
3. Click Parameter Setting and setup instrument parameters as follows: 

a. Scan No.: This parameter determines how many scans are performed during a data 

collection. If a number of greater than one is specified, the collected data is averaged. This 

increases the signal-to-noise ratio and also the total collection time. 

b. Integration No.: This parameter determines the length of time a sample is exposed 

to the light source. A high integration number increases the signal-to-noise ratio.  

c. Data Type: Select Transmittance (%T) or Reflectance (%R).  

 A Diffuse Reflector is required to measure the color of a sample in 

reflectance mode (%R). 

 
4. Setup color measurement parameters as follows: 

a. Illuminance: Select the appropriate illuminant. For example, if the illuminant is 

natural light, select D65. Options include: A, C, D50, D55, D65, F1~F12 (total 17). 

b. Observer Angle: Select the Observer Angle, 2° or 10°. 
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c. Color Scales: Select the Color Scales. Common choices are ‘CIE Yxy’ or ‘CIE L*a*b’. 

d. Color Difference Scales: For color difference measurements, select the Color 

Difference Scale. CIE dE*ab is a common choice as it returns the widely used “Delta 

E” value. 

e. CMC(l:c): Value “l” and “c” are “2” and “1” respectively. For example, CMC(2:1) is 

generally used in textile and dye industry. The l, c value can only be set for CMC and 

BFD scales. 

f. SCI/SCE: The Diffuse Reflector Accessory Integrating Sphere uses a 0/d (normal 

illumination/diffuse viewing) geometry. All measurements with this accessory exclude 

the specular component of the reflection and are therefore SCE. 

SCI: Specular Component Included - (spin) Specular reflectance is included 

SCE: Specular Component Excluded - (spex) Specular reflectance is excluded 

USE: Comparison of instrument & visual color difference 

g. Decimal Place: Enter the desired number of decimal places to display in the result 
data. 

 

5. Choose color index parameters as follows: 

a. Whiteness: Select the Whiteness. 

b. Yellowness: Select the Yellowness. 

c. Decimal Place: Enter the desired number of decimal places to display in the result 

data. 

d. APHA Concentration: If APHA measurement is used, enter the values of the APHA 

stock solution. 

e. Gardner Concentration: If Gardner measurement is used, enter the values of the 

Garner stock solution. 

 
6. When parameter setup is complete, select OK. 

 

7. Measure the Blank . This is typically a clear, colorless solution for transmission 

work, or the include Spectralon® disk if using the integrating sphere. 
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8. Measure the Target  and check the color scale result. Only one Target can be 

measured in each window. All samples are compared to the Target for the purpose of 

calculating Delta E (dE) values in color comparison measurements. 

   

 

9. Measure Samples  and check the color difference values.  

 
 

10. Print, save and export data as required. 

a. Open: Open Target, Standard or Sample data files.  

b. Save: Save the Target, Standard or Sample data separately. 

c. Export: any of the following: 

ⅰ. Result Data from the Target/Sample to an Excel readable file (*.csv). 

  ⅱ. The Result Spectrum 
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ⅲ. The Chromaticity Diagram 

ⅳ. The Concentration Chart 

d. Name: To change the name of each data, click the name column in the color result 

value window. 

 

Change name and enter. 

 

 

11. Analyze and interpret your data using the information in the fields in the window described 

below. 

 

a. Target / Sample Color: Display the color of Target and Sample. 

 

b. Result Spectrum: Display the transmittance or reflectance spectra of Standard / 

Sample. Click  to display these spectra in the full window. 

c. Result Chromaticity Diagram: Display the xy chromaticity diagram and position of 

Standard and Sample is indicated as point. Select  to 

display this diagram in the full window. 

d. Result Concentration Chart: Display the relation between color index 
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(concentration) of APHA / Gardner and their absorbance. Select 

 to display this chart in the full window. 

e. Color Result Values: Display results of Target, Standard, and Sample in 

accordance with the preset parameters. 

f. Result Data View: Select Color Quality Result or Color Indices Result to see 

various color difference values. 

ⅰ. Color Quality Result: Used to see the general color difference value. 

 

ⅱ. Color Indices Result: Used to see the result for Whiteness, Yellowness, 
Brightness, Opacity, ASTM, APHA, Gardner, ASBC-10, EBC-10.  
 

 

 

▣ APHA, Gardner Measurement Procedure 
   To perform APHA/Gardner Measurements, follow these additional steps. 

 

1. Check APHA/Gardner Use in the [Parameter Setting]→[Color Index Setup]. Click the 
edit button to setup the measurement. 
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2. Enter the concentration for Gardner or APHA standard solutions. 

 

 
3. Click Color Indices Result and select APHA or Gardner. 

 

 

4. Measure the Blank , and Standard samples . 

 
5. Save Standards. (for later use) 

 
6. If necessary, measure the Blank again.  

 
7. If the difference value between target and each sample is needed, measure the Target.  
 
8. Measure the Sample. 

 

V-1-6. Multi-Component Analysis (MCA) Mode (Optional) 
 

▣ Use Multi-Component Analysis (MCA) to analyse complex compounds containing several 

compounds. Up to 4 components in the mixture can be analysed. It is used to define the 

concentration of each component. Preform this test as follows: 

▣ Procedure 

1. Click New. 

 
2. Select Multi-Component Analysis in the Experiment Type. The method dialog box will 

be displayed. Click MCA Configurations.  
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3. The standard measurement window will be displayed. Click New  icon.   

 
4. Click Experimental Setup in the Multi-Component Analysis window. If you do not want 

to measure the new standards, click Open Standard  and choose the 

saved standards data. 

 

 

5. Setup parameters as follows. 

 
 
▶ Instrument Setting 

Enter the instrumental parameters. (Data Type, Scan No., Derivative) 

a. Data Type: Select Absorbance or Transmittance. 

b. Scan No.: This parameter determines how many scans are performed during a data 

collection. If a number of greater than one is specified, the collected data is averaged. 

This increases the signal-to-noise ratio and also the total collection time. 

 c. Integration No.: This parameter determines the length of time a sample is exposed  

to Light source. A high integration number increases the signal-to-noise ratio. 
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d. Apply Derivate: Check (√) Apply Derivative to obtain the data after applying 

derivative and enter the derivative order number (1~4). 

 
▶ Multi-Component Analysis Setting 

a. Wavelength Method: Select a calculation method for MCA. 

ⅰ. Selected Wavelength: Click Wavelength Method Setting and enter  

wavelengths to use for the test and click OK. Insert and Delete can be used to 

change the number of wavelengths used for the test. 

 

ⅱ. Range Wavelength: Enter the wavelength range to use for the test and click OK.  

 
 

b. Number of Standard (1~4): Enter the number of standards to be measured. 

c. Concentration Unit: Enter units for the standards. 
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d. Standard Parameter Setting: The following text box is displayed. Enter the 

concentration of each standard in the text box and select OK. Insert and Delete can 

be used to change the number of standards for the test. 

 
 

6. After setting all experimental parameters, click OK. 

 
 

7. Measure the blank Click Blank  icon. 
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8. Measure the standards. Click Standard  icon. Enter the name of the   

Standard and click the Enter key. 

 

9. Save the measured standard data. 

 If the standard measurement value is not saved, the sample concentration is calculated 

with the standard values saved as Default after measuring an unknown sample.  

 
10. To measure the unknown sample, save standards data and click Go To Measure   

Sample.  
 

11. The sample measurement window is displayed. 
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12. Measure the blank. 

 
13. Measure samples. Contents of each standard component in the unknown sample and its 

Chi Square value are displayed. 

 
14. Change the name of the sample. Double-click the sample. Change the sample name and 

select OK. 

 

 
 

15. Save the data. Print or export data and spectrum as required. 

◇?E A  Chi-square, χ2 

The Chi-square distribution is used in the following cases;  

a. to examine the discrepancy between an observed frequency and an expected 

frequency when more two results are acquired  

b. to examine whether the sample distribution corresponds to a binomial distribution or a 

normal distribution  

c.  to examine whether two variables are independent each of other or not. 

  
The following statistic can be used as a tool to measure the discrepancy between 
observed frequency and expected frequency: 

 

 

 

If the total frequency is "N", the following equation is formulated: 

 

 

The former equation can be also expressed as:  

 



 

 

PerkinElmer                                         UV Lab Software User’s Guide  59 

 

if χ2 = 0, the observed frequency corresponds to the expected frequency. exactly,  

 
if χ2> 0, they do not correspond exactly. That is, the larger the value of χ2, the larger 
discrepancy between the observed frequency and the expected frequency. 

 

V-2. Quantification Mode 
 
▣ Use Quantification to calculate calibration coefficients using the measured data from a set of 

standards.  

▣ Method parameters in this mode can be modified after a measurement is complete. For 

example, users can modify the wavelength at which the test is performed after the 

measurement is complete and monitor its effect on the linearity of the calibration curve used to 

quantify the sample. 

▣ Perform a Quantification Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure blank. 

4. Measure standards. 

5. Measure samples. 

6. Save or print results as required.  

 

V-2-1. Quantification Standard / Sample Mode 
 

▣ Use Quantification Standard/Sample to quantify a sample at a single wavelength using a 

reference standard. 

▣ Procedure 

1. Click New. 
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2. Select Quantification standard in Experiment Type. The Method dialog box is  

displayed. 

 
 

3. Setup Experiment Setup and Baseline Correction parameters. See IV-1-1. Wavelength 

Monitoring for more details. 

 
4. Click Quantification Standard and set parameters as follows: 

a. Analysis Name: Enter the analysis name. 

b. Concentration Unit: Enter the units for the standards. 

c. Use Wavelength (nm): Enter the wavelength to use for the test. 

d. Standard Replicate No.: Enter the number of repeated standard measurements. 

The average value of each measurement is displayed after measuring the times 

entered before. 
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e. Sample Replicate No.: Enter the number of repeated sample measurements. 

  There are two ways to check the sample measurement result. Select Measure → 

Options in the Main menu. 

  

   ⅰ) In case of checking (∨) View Replicated Samples and Average in 

Quantification in the Others tab, each repeated measurement result and the 

averaged value are displayed.  

 

ⅱ) In case of checking (∨) View Replicated Samples and Average in 

Quantification and Show Message of Replicate Number in Quantification 

in the Others tab, below message are displayed when each repeated 

measurement. 
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ⅲ) In case of unchecking View Replicated Samples and Average in 

Quantification and Show Message of Replicate Number in Quantification 

in the Others tab, the only averaged value of each repeated measurement is 

displayed.  

 

f. Curve Zero Offset: Select Yes or No to use.  

Yes No 

  

g. Curve Order: Select a 1st, 2nd or 3rd order fit for the calibration curve. 

h. Derivative Order: Choose the Derivative Order among 1st, 2nd and 3rd. The Y-axis of 

spectrum and calibration curve is changed as selected. 

 

5. Select Standard Concentration. 

 

6. Enter the concentration for each standard in the test box, as shown below and select OK. 

Insert and Delete can be used to change the number of standards for the test. 
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7. After setting parameters for Experiment Setup, Baseline Correction and 

Quantification Standards is complete, click OK in the method setup window.  

 
8. Measure the blank. 

 

9. Measure the standards according to their concentrations. The spectra and resulting 

calibration curve are displayed as follows. The equation and correlation coefficient for the 

curve are displayed below the Standard Spectrum window. 

  
 

10. Select Quantification Sample.  
 

11. Measure the sample (unknown). 
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12. The concentration of each sample is calculated automatically. 

 
 

13. If samples were diluted prior to measurement, the original concentration may be 

calculated using a dilution factor as shown below: 

 

 
14. Save or print data and spectra as required. 

▶ To edit a sample name or a dilution factor, double click the sample line to be changed in 
the list. 
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V-3. Kinetics Mode 
 
▣ Use Kinetics to test reaction rate. This mode includes the following Experiment Types: 

• Time Based Kinetics 

• Temperature Based Kinetics 

• Ultra Kinetics  

▣ Perform a Kinetics Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure blank. 

4. Measure samples. 

5. Save or print results as required.  

 

V-3-1. Time Based Kinetics Mode 
 
▣ Use Time Based Kinetics to test the reaction rate against time 

▣ Procedure 

1. Click New. 

 
2. Select Time Based Kinetics in the Experiment Type. The method dialog box is 

displayed. 
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3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 

 
4. Select Time Based Kinetics and setup test parameters as follows: 

a. Time Unit: Choose a time unit (min, sec, msec). 

b. Interval Time: Set the interval time during Start and End Time. Select Insert and 

Delete to add interval time. 

ⅰ. Time Unit - Min: Recommended Interval is over 1min  

ⅱ. Time Unit - sec: Recommended Interval between 5 ~ 60 sec  

ⅲ. Time Unit - msec: Recommended Interval between 650 ~ 2000 msec 

 Kinetics mode provides multi-step interval time. Both single-step interval and 

multi-step interval can be set by adding or delete step of interval. 

   
c. Total Run Time: Show the total run time for testing samples. 

d. Initial Delay Time: Set the holding time before the first sample measurement. If “0” 

is entered for the initial delay time, the measurement is taken immediately. 

e. Rate Calculation Type: Select the order for the rate calculation. Select  

Form: Zero Order, Initial Rate, First Order and Delta Au. See the end of this section for 

more information. 

f. Rate Calculation Start Time: Enter the time to start calculating the rate. 

g. Rate Calculation End Time: Enter the time to stop calculating the rate. 

 The Start and End Time must be within the total run time set for the test. 

  
5. Click Kinetics Wavelength Range.  
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6. Enter the desired wavelength range for the measurement and click OK.  

  

 The number of wavelength Range should be matched the number of Using Cell. If the 
Wavelength Range is set as the picture below, multi cell number should be selected three 
cells and in numerical order on using cells in the 8 Multi-Cell Holder Setup window. 
For example, Cell No.2 for wavelength 300 nm, Cell No.3 for wavelength 500 nm, Cell No.5 
for wavelength 700 nm. 

 
 

7. Select Full Spectrum Monitoring Wavelength.  
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8. Enter the wavelength for the measurement and select OK. 

 

9. After setting parameters for Experiment Setup, Baseline Correction and Time Based 

Kinetics is complete, select OK. 

 
10. Measure the blank. 

 
11. Measure samples. The overlay of all the full spectra is displayed in the Spectrum Radar 

window during the entire measurement.  

 

12. After the experiment is complete, the Regression Curve is generated as shown in the 

picture below. 
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13. To see the full wavelength spectrum of the samples, click Full Spectrum. 

 

14. Print and save spectra and data as required. 

 

◇?E A Rate Calculation Type 

Four Rate Calculation types are available. These include: 

 
▶ Zero order 

Uses a linear fit to calculate the rate, k, by linear regression using the equation: 

At = A0 – kt 

 
At is the absorbance at time t. 

Ao is the absorbance at the start of the calculation time range. 

k is the zero order rate constant [Units: AU/s]. 

  

▶ Initial Rate 

Uses a quadratic fit to calculate the rate, k, by linear regression using the equation:   

                          
At = A0 + kt + t2 

 
At is the absorbance at time t. 

   A0 is the initial absorbance.  

 k is the initial rate [Units: AU/s]. 

 

▶ First order 
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    Uses an exponential fit to calculate the rate, k, using the rate law: 

 
At = A∞+ (Ao-A∞) e-kt 

 
This rate law can be rearranged to  

 
ln(At −A∞)= ln(Ao-A∞) − kt  

 

At is the absorbance at time t. 

A0 is the initial absorbance.  

k  is the first order rate constant [Unit: 1/s]. 

 

▶ Delta AU 

Uses the difference between the absorbance at the start of the calculation time range 
and the absorbance at the end. This calculation is very simple and can be expressed 
as: 
 
Delta AU = At − A0 

 

At is the absorbance at time t. 

A0 is the initial absorbance.  

Delta AU [Units: AU].  

 

 

V-3-2. Temperature Based Kinetics Mode 
 

▣ Use Temperature Based Kinetics to test the reaction rate against temperature. 

▣ Procedure 

1. Select New. 
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2. Select Temperature Based Kinetics in Experiment Type. The method dialog box is 

displayed. 

 

 
3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. In Sampling Type of Experiment Setup, select Single Cell 

Peltier or Muti-Cell Peltier. 

 For more details of the Peltier Accessory temperature setting, refer to the Single Peltier 

Temp Ctrl Unit L465 or Multi Peltier Temp Ctrl Unit L465 manual. 

 

4. Select Temperature Based Kinetics and setup test parameters as follows: 

a. Edit Heating(Cooling) Rate (℃/min): Set the temperature interval for one 
minute. 

 Temperature based kinetic mode provides multi-step ramping. Both single-step 
ramping and multi-step ramping can be set by adding or delete step of interval. 



 
 

72  UV Lab’s Software User Guide                                         PerkinElmer 

 Sample is measured as interval of rate. 

 
b. Start Temperature: Enter the start temperature for the measurement. 

c. End Temperature: Enter the end temperature for the measurement. 

d. Holding Time: Select the holding time at each temperature. 

e. Rate calculation Type: Select the rate calculation type. See V-3-1. Time Based 

Kinetics for more information. 

f. Calculation Start Temperature: Enter the start temperature for the calculation. 

g. Calculation End Temperature: Enter the end temperature for the calculation. 

 The Calculation Start and Calculation End Temperature must be within the 

Start and End temperatures for the measurement. 

 
5. Select Wavelength Range. 

 
6. Enter the wavelength range for the measurement and click OK.  
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 The number of wavelength Range should be matched the number of Using Cell. If the 
Wavelength Range is set as the picture below, peltier multi cell number should be selected 
three cells and in numerical order on using cells in the 8 Multi-Cell Holder Setup 
window. For example, Cell No.2 for wavelength 300 nm, Cell No.3 for wavelength 500 nm, 
Cell No.5 for wavelength 700 nm.  

 
 

7. Measure the Blank. 

 
8. Measure samples. 

 
9. Print and save spectra and data as required. 

 
 

 

V-3-3. Ultra Kinetics Mode  

▣ Use Ultra kinetics to measure a very fast kinetic reaction.  

▣ Measurement can be performed with an interval time as low as 20 ms in this mode. Perform this 
type of experiment as follows: 

▣ Procedure 

1. Click New. 
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2. Select Ultra Kinetics in the Experiment Type. The method dialog box is displayed. 

 
 

3. Enter each parameter as follows. The interval time and total time are calculated 

automatically in the Test Result window. 

  
a. Interval Time (s): Enter the interval time between measurements. This parameter 

is related to Integration No. The minimum interval time is 0.02 sec. 

b. Total Data Number: Enter the number of data points desired. The max. Sampling 

No. is 50000. 

c. Total Time (s): Will be set automatically according to both the Interval time and the 

Total Data Number. 

d. Baseline Correction: Check (√) Baseline Correction box to apply for the Baseline 

correction and enter the wavelength in the Base Wave(nm). 
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e. Display Start Wave (nm): Enter Start Wave for the display in the Spectrum chart. 

f. Display End Wave (nm): Enter End Wave for the display in the Spectrum chart.  

g. One Spectrum Monitoring: Show the last spectrum obtained.  

h. All Spectra Monitoring: Show the whole spectrum obtained.  

i. Kinetics Wave 1 / 2 (nm): Enter the specific wavelength 1 / 2 to calculate the 

reaction rate. 

j. Calculation: Select the order for the rate calculation among Zero Order, First Order 

and Delta Au. (Refer to Time Based Kinetics chapter for the details) 

k. Start Time (s): Enter the time to start calculating the rate. 

l. End Time (s): Enter the time to stop calculating the rate. 

 Both the start time and the end time shouldn’t be a bigger than the total 

run time. 

m. Factor: Enter the factor for the calculation. 

 
4. After setup is complete, click OK.  

 
5. Measure the Blank. 

 
6. Measure the sample. Each reaction rate of selected wavelength 1 and wavelength 2 will be 

calculated in the kinetics chart. 

 

 Drag Bar: Confirm the spectrum data at specific time which is pointed by drag bar at the 

Kinetics Chart 

Drag Bar 
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7. Save the data. [*.akt] 

 The set-up parameters of ‘Base Wave’, ‘Display Start Wave’, ‘Display End 
Wave’, ‘Kinetics Wave’, ‘Start Time’, ‘End Time’ and ‘Factor’ can be changed 
after the test and then the new results will be shown accordingly.  

 

8. Print, save or export data and spectrum as required. 

 
V-4. Bio Mode 

 

▣ Use Bio to perform pre-programmed biological test. This mode includes the following 

Experiment Types: 

• Nucleic Acid Analysis 

• Protein Analysis 

• Cell Density 

• Enzyme Activity 

• Enzyme Mechanism 

• Thermal Denaturation 

 

▣ Perform a Bio Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure blank. 

4. Measure samples. 

5. Save or print results as required.  

 
 

V-4-1. Nucleic Acid Analysis Mode 
 

▣ Use Nucleic Acid Analysis Methods to perform ratio and concentration measurements on 

samples containing proteins and nucleic acids.  

 
▣ Procedure 

1. Select New. 

 
2. Select Nucleic Acid Analysis in the Experiment Type. The method dialog box is 

displayed. Select the cell pathlength in the Nucleic Acid method and click Open. 
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3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 

 
 

4. Setup test parameters in the Nucleic Acid Analysis tab as follows: 

a. Analytical Name: Enter the analytical name. 

b. Calculation Type: Select the calculation type. 
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◇?E A Calculation Type 

The Nucleic Acid application is used for determining the concentration and purity of 
nucleic acid samples. The reading at 260 nm allows to calculate the concentration.   

 

▶ dsDNA, ssDNA, RNA, Oligo DNA 

   [Nucleic Acid Concentration] ug/ml = A260 x extinction coefficient x D.F 

 
Where,  

A260 is Absorbance at 260 nm. 

Extinction coefficient :  

The generally accepted extinction coefficients for nucleic acids are: 

Coefficient  Value 

dsDNA 50 ug/ml 

ssDNA 37 ug/ml 

RNA 40 ug/ml 

Oligo DNA 33 ug/ml 
   D.F is dilution factor. 

 

▶ Warburg-Christian 

  The Warburg-Christian assay with pre-selected parameters calculates protein and 
nucleic acid concentrations (in micrograms per ㎖) using the following equations with 
absorptivities calculated by Warburg and Christian.  

 
[Protein] = (1552 * A280) - (757.3 * A260), 

[Nucleic Acid] = (62.9 * A260) – (36.0 * A280) 

 
where, the absorbance at 260 nm and 280 nm are corrected for the baseline at 320 nm. 

 

▶ Kalb and Bernlohr 

  The Kalb and Bernlohr assay with pre-selected parameters calculates protein and 
nucleic acid concentrations (in micrograms per ㎖) using the following equations. 
[Protein] = (183.0 * A230) - (75.8 * A260), 

[Nucleic Acid] = (49.1 * A260) – (3.48 * A230) 

 
where, the absorbance at 260 nm and 230 nm are corrected for the baseline at 320 nm. 

 
c. Concentration Unit: Enter the concentration unit for the samples. 

d. Cell Pathlength: Enter the cell (beam) pathlength. 

e. Dilution Factor: Enter the dilution factor. 

f. Nucleic Acid Factor: Will be set automatically according to calculation type. 
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UV Lab uses factors 50, 37, 40 and 33 as default settings for dsDNA, ssDNA, RNA and 

Oligonucleotides.  

 

5. After setting parameters for Experiment Setup, Baseline Correction and Nucleic Acid 
Analysis is complete, click OK. 

 
6. Measure the blank. 

 
7. Measure samples. 

 
8. Save and print spectra and data as required. 

 

V-4-2. Protein Analysis Mode 
 

▣ Use Protein Analysis to quantify the amount of protein in a sample. Select from 

pre-programmed frequently used methods for quantifying proteins. 

▣ Procedure 

1. Select New. 
 
2. Select Protein Analysis and select OK. 
 
3. Method Open dialog box is displayed. Choose the method and select OK. 

 
 

4. The method dialog box is displayed. Setup test parameters and click OK.  
 

5. Measure the Blank. 
 

6. Measure samples. 
 

7. Save and print spectra and data as required. 
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A◇?E A Protein Analysis Method 

The study of many biochemical processes depends upon an accurate 
measurement of the amount of protein in solution. This has led to the development 
of several protein quantification methods, the most common of which are 
described below.  
 

Method Name Reagents 
Wavelength 

[nm] 

Concentration 
Range 

[µg/ml] 
Method File 

Biuret Dilute copper sulfate in strong alkali 540 200–2000 Biuret.mtd 

Lowry 
(high sensitivity) 

Dilute copper sulfate in strong alkali 
and Folin-Ciocalteu reagent 750 4–200 Lowryhigh.mtd 

Lowry 
(low sensitivity) 

Dilute copper sulfate in strong alkali, 
Folin-Ciocalteu reagent 500 60–400 Lowrylow.mtd 

Lowry 
(modified) 

Dilute copper sulfate in strong alkali 
and Folin-Ciocalteu reagent and 
dithiothreitol 

740 3–200 Lowry.mtd 

Bradford Goomassie Brilliant Blue G250 in 
dilute acid 595 2–50 Bradford.mtd 

Bicinchoninic 
acid (BCA) Bicinchoninic acid 562 4–400 BCA.mtd 

Trinitrobenzene 
Sulfonate 
(TNBS) 

Hydrochloric acid and 
trinitrobenzene reagent 416 0.5–100 TNBS.mtd 

 

1. Biuret Method 

Biuret (NH2-CO-NH-CO-NH2) produces a violet chelate compound when reacting with 
alkali CuSO4. 

 

Using the theory that a compound which has more than two peptide bonds also produces 
a chelate compound, by the same procedure as in the Biuret case, one can determine the 
protein concentration. Approximately, 1~10 mg of protein can be quantified by the 
Biuret method. Using a microassay one can measure as 0.25 mg~2.0 mg of protein. A 
chelate compound is usually stable for 1~2 hours but its chromaticity gradually increases 
with time. The absorbance of the sample in the test tube is measured at 540 nm. 
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2. Lowry Method 

The Lowry procedure is one of the most venerable and widely used protein assays, being 
first described in 1951 [Lowry et al., J. Biol. Chem. 193: 265-275 (1951)]. Under alkaline 
conditions, copper complexes with protein. When folin phenol reagent 
(phospho-molybdic-phosphotungstic reagent) is added, the folin-phenol reagent binds to 
the protein. Bound reagent is slowly reduced and changes color from yellow to blue. The 
Lowry method is more sensitive than the Biuret method and can measure 10~200 µg of 
protein. The absorbance of the sample in the test tube is measured at 750 nm. 
 

3. Bradford Method  

One of the most widely used methods was developed by Bradford; it is based upon a shift 
in the absorption spectrum of Coomassie Brilliant Blue G-250 when the dye binds to 
protein in an acidic solution. The method is fast, convenient, and produces an equivalent 
absorbance change for many different proteins. The absorbance of the resulting solution 
is measured spectrophotometrically at 595 nm and compared to a standard curve 
generated using known quantities of a control protein in the dye solution. In this method, 
color reaction is completed very quickly (in 2 min.) and it is stable for 1 hour.  
The Bradford method is more sensitive than the Lowry method and can measure 1~20 
µg of protein using micro assay. The Bradford method is faster and is seldom affected by 
non-protein components. 
 

4. BCA Protein Assay 

BCA Protein Assay uses a detergent-compatible formulation based on bicinchoninic acid 
(BCA) for the colorimetric detection and quantification of total protein. This method 
combines the well-known reduction of Cu+2 to Cu+1 by protein in an alkaline medium (the 
Biuret reaction) with the highly sensitive and selective colorimetric detection of the 
cuprous cation (Cu+1) using a unique reagent containing BCA. The purple-colored 
reaction product in this assay is formed by the chelation of two molecules of BCA with 
one cuprous ion. This water-soluble complex exhibits a strong absorbance at 562 nm that 
is nearly linear with increasing protein concentrations over a broad working range 
(20-2,000 µg/ml). The BCA method is not a true end-point method; i.e., the final color 
continues to develop. However, following incubation, the rate of continued color 
development is sufficiently slow to allow large number of samples to be assayed 
together. 

 

V-4-3. Cell Density 
 

▣ Use Cell Density to determinate the absorbance at 600 nm.  

▣ Procedure 

1. Click New. 
 
2. Select Cell Density and click OK. 
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3. Method dialog box is displayed.  

 
 

4. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. Setup test parameters and click OK.  

a. Factor: Set a desired factor value. [used when entering cell/ml in Units] 

b. Multiplier: Set a desired Multiplier value. [used when entering cells/ml in Units] 

 Factor and Multiplier define the conversion of the measured OD to the number of 
cells per milliliter (e.g.: Factor 5, Multiplier: 100,000,000) 
1 OD 600 = 5 x 108

 cells/ml 

 When entering OD in Units, set the Factor and Multiplier as 1. 
 
c. Units: Enter OD or cells/ml.  
 

5. Measure the Blank. 
 

6. Measure samples. 
 

7. Save and print spectra and data as required. 

 

 

V-4-4. Enzyme Activity Mode 
 

▣ Use Enzyme Activity Methods to calculate enzyme activity from a set of kinetic samples. 

▣ Procedure 

1. Click New. 

 
2. Select Enzyme Activity in the Experiment Type. The method dialog box is displayed. 
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3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 

 
4. Select Enzyme Activity and setup test parameters as follows:  

a. Time Unit: Choose a time unit (min, sec, msec). 

ⅰ. min unit: Recommended Interval Time: over 1min  

ⅱ. sec unit: Recommended Interval Time: 5 ~ 60 sec  

ⅲ. msec unit: Recommended Interval Time: 650 ~ 2000 msec 

b. Total Run Time: Enter the total time for measuring samples. 

c. Initial Delay Time: Set the holding time before the first measurement. If “0” is 

entered for the initial delay time, the measurement is taken immediately. 

d. Interval Time: Set the interval time between the measurements. 

e. Rate Calculation Type: Select the order for the rate calculation. Select 

form: Zero Order, Initial Rate, First Order and Delta Au. See V-3-1. Time Based 

Kinetics for more information. 

f. Start Time: Enter the time to start calculating enzyme activity. 

g. End Time: Enter the time to stop calculating enzyme activity. 

h. Enzyme Activity Unit: Enter the enzyme activity unit. 

i. Enzyme Activity Factor: Enter the enzyme activity factor to calculate the  

enzyme activity. This value can be calculated using the equation in the box below.  
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ε = molar absorption coefficient (M-1cm-1) 

b = cell pathlength (cm)  

Vf = final volume in the cuvette (l) 

A = absorbance 

t = time (min) 
 

5. Click Wavelength Range.  
 
6. Enter the wavelength range for each measurement and click OK. See V-3-1. Time 

Based Kinetics for more information. 

 
 

7. After setting parameters for Experiment Setup, Baseline Correction and Enzyme Activity is 

complete, click OK. 

 
8. Measure the Blank. 

 
9. Measure Sample. The overlay of all the spectra is displayed in the Spectrum Radar window 

during the entire measurement. 

 
10. After the experiment complete, the Regression Curve is generated. 

 

11. Save and print spectra and data as required. 
 

 

Unit =                 =       *             *         * Vf (L)   
µmol produced  

min △t ε(M-1cm-1) b 

△A 1 

M 

106 µM   
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V-4-5. Enzyme Mechanism Mode 
 
▣ Use Enzyme Mechanism Methods to collect the plots, Km and Vmax from a set of kinetic samples. 

▣ Procedure 

1. Click New. 

 
2. Select Enzyme Mechanism in the Experiment Type. The method dialog box is displayed. 

 

 
3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. 

 
4. Click Enzyme Mechanism and setup test parameters as follows: 

a. Time Unit: Choose a time unit (min, sec, msec). 

ⅰ. min unit: Recommended Interval Time: over 1min  

ⅱ. sec unit: Recommended Interval Time: 5 ~60 sec  

ⅲ. msec unit: Recommended Interval Time: 650 ~ 2000 msec 

b. Total Run Time: Enter the total run time for measuring samples. 

c. Initial Delay Time: Set the holding time before the first measurement. If “0” is 

entered for the initial delay time, the measurement is taken immediately. 

d. Interval Time: Set the interval time between the measurements. 

e. Rate Calculation Type: Select the order for the rate calculation. Select form: Zero 

Order, Initial Rate, First Order and Delta Au, See V-3-1. Time Based Kinetics for 

more information. 
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f. Start Time: Enter the time to start calculating enzyme activity. 

g. End Time: Enter the time to stop calculating enzyme activity. 

h. Enzyme Activity Unit: Enter the enzyme activity unit. 

i. Enzyme Activity Factor: Enter the enzyme activity factor to calculate the enzyme 

activity. 

 
5. Select Substrate Concentration. 

 
6. Enter the wavelength range and substrate concentration for each test and select OK. 

  
 

7. After setting parameters for Experiment Setup, Baseline Correction and Enzyme 

Mechanism is complete, select OK. 

 
8. Measure the blank. 

 
9. Measure samples in the order of the Substrate Concentration. The overlay of all the full 

spectra is displayed in the Spectrum Radar window during the entire measurement.  

 

10. To see enzyme plot, click ViewEMResult.  

 

 

11. Click ▼ and select a plot type to open. ( Michaelis-Menten, Lineweaver-Burk, Hanes-Woolf, 

Eadie-Hofstee Plot) 
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12. The graph can be viewed if a single plot is selected. 

 

13. Save and print spectra and data as required. 

 

◇?E A Enzyme Mechanism Plots 

The effect of the substrate concentration on the rate of an enzyme-catalyzed reaction is 

shown graphically by the Michaelis-Menten plot. The Michaelis- Menten plot is 

constructed from the analysis of a set of samples with varying substrate concentration. 

The concentrations for each set are entered and stored with the rates of each sample. 

Three other plots are derived from the Michaelis-Menten equation, namely, 

Lineweaver-Burk plot, Hanes-Woolf plot, Eadie-Hofstee plot. 

 

Michaelis-Menten Plot                    Lineweaver-Burk Plot 

    
 

 

Hanes-Woolf Plot                         Eadie-Hofstee Plot 
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V-4-6. Thermal Denaturation Mode 
 

▣ Use Thermal Denaturation modes to collect the temperature based data and perform a classical 

DNA melting experiment. 

▣ Procedure 

1. Select New. 

 
2. Select Thermal Denaturation in Experiment Type. The method dialog box is displayed. 

 

 
3. Setup Experiment Setup and Baseline Correction parameters. See V-1-1. Wavelength 

Monitoring for more details. Select the Single Cell Peltier or Multi-Cell Peltier in Sampling 

Type of Experiment Setup. 

 
4. Click Thermal Denaturation and setup test parameters as follows:  

a. Edit Heating(Cooling) Rate (℃/min): Set the temperature interval for one 
minute. 

 Thermal mode provides multi-step ramping. Both single-step ramping and multi-step 

ramping can be set by adding or deleting step of ramping. Measure the sample as 

rate interval. 
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 Sample is measured as interval of rate. 

 

b. Start Temperature: Enter the start temperature for the measurement. 

c. End Temperature: Enter the end temperature for the measurement. 

d. Holding Time: Enter the holding time at each temperature. 

e. Volume Correction: If volume correction is selected, the baseline corrected 

absorbance value is corrected for the thermal expansion of an aqueous buffer. The 

default equation for volume correction is: 
 

Volume (T) = 0.99829+104.5 * 10-6T+3.5 * 10-6T2 
 
 

f. Tm method: Select a method for determining Tm (DNA melting temperature). 

Options include: 1st derivative and Average.  

g. DNA Pair Length (K): Enter the DNA pair length. If a DNA pair length is above 5000, 

enter as “0”. 

h. Equation Name and Expression: The melting range is calculated within the 

specified calculation range by defining the low temperature where the slope begins to 

increase steadily, and the high temperature where the slope approaches zero again. 

The default equation for the calculation of %G-C (Guanine-Cytosine) base pairs is: 

 
%G-C=2.44 * ( Tm – 81.5 - 16.66 * log(M) + 500/K ) 

 
Where M is the molarity in mol/l, K is the DNA base pair length. 

 

If a DNA base pair length (K) is entered as ‘0’, then the equation becomes: 

%G-C= 2.44 * ( Tm - 81.5- 16.66 * log(M) ) 
 

i. Calculation Start Temperature: Enter the start temperature for calculating the 

Tm value using the selected method. 

j. Calculation End Temperature: Enter the end temperature for calculating the 

Tm value using the selected method. 
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5. After setting parameters for Experiment Setup, Baseline Correction and Thermal 

Denaturation are complete, select OK. 

 
6. Measure the blank. 

 
7. Measure samples. 

 
8. Save and print spectra and data as required. 
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VI. View Menu 
 

 

▣ The View menu includes commands to change and customize software windows as show 

below. 

 

Command Function 

Move Select another experiment mode 

Absorbance Display the unit of Y-axis by absorbance 

Transmittance Display the unit of Y-axis by transmittance 

Reflectance Display the unit of Y-axis by reflectance 

Intensity Display the unit of Y-axis by intensity 

Spectrum Radar Display spectrum radar on the screen 

Spectrum List Display spectrum list on the screen 

Spectrum Information Display spectrum information on the screen 

View Bar Display view bar on the screen 

Measure Bar Display standard toolbar on the screen 

Standard Toolbar Display standard toolbar on the screen 

Trace Bar Display trace bar on the screen 
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Status Bar Display status bar on the screen 

Lamp Bar  Display lamp bar on the screen 

Experiment Information  Display experiment information 

User Information Display user information 

Customize Change toolbar style 

Reset Tool Bar Reset toolbar on the screen 

 
 
 

VI-1. Move 
 
▣ Use the Move command to select the experiment method. A new window and method will be 

displayed.  

 
 
 

VI-2. Absorbance 
 
▣ Use the Absorbance command to convert the unit of the Y-axis to absorbance mode. 

▣ Procedure 

1. Select Absorbance, and the unit of the Y-axis changes to absorbance mode. 
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VI-3. Transmittance 
 
▣ Use the Transmittance command to convert the unit of the Y-axis to transmittance mode. 

▣ Procedure 

1. Select Transmittance and the unit of the Y-axis changes to transmittance mode. 

 
 

VI-4. Reflectance  
 
▣ Use the Reflectance command to convert the unit of the Y-axis to reflectance mode. 

▣ Procedure 

1. Select Reflectance and the unit of the Y-axis changes to reflectance mode. 

 
 

VI-5. Intensity 
 
▣ Use the Intensity command to convert the unit of the Y-axis to intensity mode. 

▣ Procedure 

1. Select Intensity and the unit of the Y-axis changes to intensity mode. 

 
 

VI-6. Experimental Information 
 
▣ Use the Experiment Information command to exchange the experiment information. 

▣ Procedure 

1. Select Experiment Information.  

 

 
2. Enter Title, System Name and Comment information.  
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3. Select OK. You can check Experiment Information at the print. 

 
 
 

VI-7. User Information 
 
▣ Use the User Information command to exchange the user information. 

▣ Procedure 

1. Select User Information. 
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2. Enter Name and Company information and click OK. You can check Company information 

at the print. You can check User Information at the print. 

 

 
 

VI-8. Customize 
 
▣ Use the customize command to hide and create the toolbars and disable all of the user's 

editing options. 
▣ Procedure 

1. Click Toolbars tab.  
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2. Select toolbars desired. 

 
 

3. Select New. Enter the new toolbar name and select OK. 

  
 

4. Select the Commands tab.  
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5. You can create a tab. Select Keyboard. The following dialog box will be displayed. 

  
 

6. Select Options tab.  
  

7. Choose the options required, and then select Close. 
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VII. Math Menu 
 

 
▣ The Math menu includes commands to analyze the collected data. 

 
 

 
 
 
 
 

Command Function 

Smoothing 
Derivative 

Smooth the spectrum 
Obtain the data after applying a derivative 

Scalar Add 
 

Add a constant value to the y-value in the 
spectrum 

Scalar Multiply 
 

Multiply the y-value in the spectrum by a constant 
value 

Scalar Divide 
 

Divide the y-value in the spectrum by a constant 
value 

Log 
 

Compute the common logarithm of the y-value in 
the spectrum 

Add 
Subtract 
Average 

Obtain the added data of selected spectra 
Obtain the subtracted data of two spectra 
Obtain the average data of the selected spectra 

Area Perform to calculate the area 
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VII-1. Smoothing 
 

▣ Use the Smoothing command to smooth the spectrum. 

▣ Procedure 

1. Select Smoothing. The following dialog box is displayed. 

 

 

2. Set the function parameters. 

a. Smoothing: Select Yes or No. 
 
b. Window Size: Select the data point to use to smooth the spectrum. 

 
c. Polynomial Degree: Select the dimension of curve fitting.  
 
d. Processing Spectrum: Select Add new spectrum or Change original spectrum. 

 
3. After setting parameters is complete, click OK. The result is displayed in the main window. 
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A◇?E A Savitsky-Golay Smoothing 

UV Lab uses the Savitsky-Golay method for the data smoothing. Using the Savitsky-Golay 
method results in the elimination of (window size)/2 points on each end of the smoothed 
value in the middle of the window. It is the preferred method for noise reduction and is 
also recommended for smoothing because no truncation of the data occurs. 
 

 

VII-2. Derivative 
 
▣ Use the Derivative command to obtain the derivative data of the spectrum. 

▣ Procedure 

1. Select Derivative. The following dialog box will be displayed. 

  

 
2. Click OK after entering the Derivative Order number and selecting the Processing 

Spectrum. The result will be displayed in the main window. 

 
 

VII-3. Scalar Add 
 
▣ Use the Scalar Add command to add a value to the Y-axis of a spectrum 

▣ Procedure 

1. Select Scalar Add. The following dialog box will be displayed. 

  

 
2. Enter the value to add to the spectrum. 

 
3. Select Add new spectrum or Change original spectrum. 

 
4. Click OK. The result will be displayed in the main window. 
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VII-4. Scalar Multiply 

 

▣ Use the Scalar Multiply command to multiply the Y-axis of a spectrum by a value 

▣ Procedure 

1. Select Scalar Multiply. The following dialog box will be displayed. 

  

 
2. Enter the value to multiply the spectrum. 

 
3. Select Add new spectrum or Change original spectrum. 

 
4. Select OK. The result will be displayed in the main window. 

 
 

VII-5. Scalar Divide 
 

▣ Use the Scalar Divide command to divide the Y-axis of a spectrum by a value 

▣ Procedure 

1. Select Scalar Divide. The following dialog box will be displayed. 

  
 

2. Enter the value to divide the spectrum. 

 
3. Select Add new spectrum or Change original spectrum. 

 
4. Select OK. The result is displayed in the main window.  
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VII-6. Log 
 
▣ Use the Log command to compute the log of a spectrum. 

▣ Procedure 

1. Click Log. The following dialog box will be displayed. 

  

 
2. Select Add new spectrum or Change original spectrum. 

 
3. Select OK. The result is displayed in the main window. 

 
 

VII-7. Add 
 
▣ Use the Add command to add the Y-axis values of selected spectra. 

▣ Procedure 

1. Select desired spectra to add together by clicking the spectra while holding down the Ctrl 

key.  

 
2. Click OK. The result is displayed in the main window. 

 
 

VII-8. Subtract 
 
▣ Use the Subtract command to subtract the Y-axis values of two spectra. 

▣ Procedure 

1. Select two spectra to subtract by clicking the spectra while holding down the Ctrl key. The 

following dialog box is displayed. 

 

 
2. Select the appropriate equation. 
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3. Click OK. The subtracted result is displayed in the main window. 

 

 

VII-9. Average 
 

▣ Use the Average command to calculate the average of selected spectra. 

▣ Procedure 

1. Select the spectra to average together by clicking the spectra while holding down the Ctrl 
key or using the Select All command. 

 
2. Select OK. The average result is displayed in the main window. 

 

 

 

VII-10. Area 
 

▣ Use the Average command to calculate the average of selected spectra. 

▣ Procedure 

 Use the Area command to calculate the are in the specified range 

 Procedure 

1. Select Area. The following dialog box is displayed. 

 
 

2. Set the parameters. 

a. Exclude Baseline: Exclude the baseline from the calculated area value automatically. 
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b. View Area Value: Display the area value in the result window. 

c. Start Wave (nm): Enter the start wavelength for the area calculation. 

d. End Wave (nm): Enter the end wavelength for the area calculation. 

e. Area: Display the calculated value.  

3. After entering the parameters, click Area icon.  

 

4. The calculated area and range are displayed in the Area tab. If you check View Area 

value, the area and range are displayed in the result window. 
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VIII. Display Function Tools 
 
▣ Use the display function tools to modify the display of the main window as desired. 

 

Tool icon Function Tool icon Function 

 Zoom In  Pick Peak 

 
Zoom Reset  Pick Valley 

 
Y Axis 
Auto Scale  

Cursor 

 
Add Label 

 
To Left 

 
Edit Label 

 
To Right 

 Properties  
View 3D for 
kinetics mode 

 
 

VIII-1. Zoom In / Reset / Auto scale 
 
▣ Use these icons to zoom , reset and auto scale the selected area in the main window. 

▣ Procedure 

1. Select Zoom In. 

 
2. Select the zoom area using the mouse, as shown. 

  

 
3. To restore the original range, click Zoom Reset. 

 
4. To Auto scale the Y axis, click the Y Axis Auto Scale. 
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VIII-2. Add / Edit / Delete Label 
 
▣ Use these icons to add, edit and delete labels in the main window.  

▣ Procedure 

1. Select Add Label. 
 
2. Set the label at the required position using the mouse, as shown below. 

 
3. The following dialog box will be displayed. 

 
 

4. Enter comments, and select a font style and size. 
 
5. Select OK. 

 
 

6. To edit or delete the labels, click Edit Label and edit or delete the labels as desired. 
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VIII-3. Pick Peak / Valley 
 
▣ Use these icons to pick peaks/ valleys or seek the data. 

▣ Procedure 

1. Select Pick Peak/ Valley.  

 
2. Select the spectral range using the mouse. The labels of the peaks or valleys are displayed 

as shown below. 

   
3. To delete a peak/valley, select the peak/valley in the result window and click the right 

mouse. 
 

4. Select delete or delete all as shown. 

 
 

 

VIII-4. Properties and Display Interval 
 
▣ Use these icons to change chart properties in the main window, such as the chart color, 

display interval, grid, X Axis, Y Axis and line properties. 

▣ Procedure 

1. Select Properties.  
 

2. Change properties as follows. 

 
3. Select OK when finished.  



 
 

110  UV Lab’s Software User Guide                                         PerkinElmer 

 
a. Chart: Choose the colors of the background and Axis color.  
 
b. Display Interval: Select the wavelength display interval: 0.1 nm, 0.5 nm, 1 nm, 2 nm. 
 
c. Legend: Select to display the legend on the chart and where to position it. 
 
d. Grid: Select to display X and Y grids. 
 
e. X, Y Axis: Set the range of X and Y Axis. 
 
f. Line: Select the color and pattern of the spectrum lines. 

 

VIII-5. 3D Graphic mode 
   
▣ It is possible to use the 3D the graphic mode in the kinetics modes: Time Based Kinetics and 

Temperature Based Kinetics, and the Bio modes: Enzyme and Thermal Denaturation. Click 

Veiw 3D to use this feature.  

 
 
 
 
 
 
 
 
 

3D Graphic Spectra Mode                  Time Based Kinetics 
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IX. Window Menu 
 

 
 

▣ The Window Menu to arrange the windows and show the current windows. 

 

 

Command Function 

Tile Horizontally 
Tile Vertically 
Cascade 

Display the windows in the horizontal tile mode 
Display the windows in the vertical tile mode 
Display the windows in the cascade mode 

 
 
 

IX-1. Tile Horizontally 
 
▣ Use the Tile Horizontally command to align the windows in the horizontal tile modes as below. 

 
 



 
 

112  UV Lab’s Software User Guide                                         PerkinElmer 

IX-2. Tile Vertically 
 
▣ Use the Tile vertically command to align the windows in the vertical tile mode as below. 

 
 

IX-3. Cascade 
 
▣ Use the Cascade command to align the windows in the cascade mode as below. 

 
 
▣ The titles of the current windows are displayed as below. 

  

▣ Procedure 

1. To view a different window, click the window you want to view and the selected window is 
displayed.  

 

2. When the data in the window is saved, the file titles are listed. 
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X. Help Menu 
 

 
▣ The Help Menu contains the Help contents for UV Lab software. 

 

  
 
 

 

X-1. Contents 
 
▣ Use the help section for suggestions on using UV Lab software more effectively. 

 

X-2. About... 
 
▣ About UV Lab contains information on the version of the software as shown below. 

 

 
 

Command Function 

Contents 
About... 

Display UV Lab Software Users guide as PDF file 
Display the version of UV Lab Software 
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XI. System Monitoring 
 
 

▣ Use System Monitoring to check the overall condition of the instrument. It provides a 

step-by-step explanation with figures, for the wavelength calibration of the spectrophotometer 

and the position calibration of the ARS (Water Jacketed Automatic Referencing Stage) and 8 

Cell Water Jacketed Cell Changer. 
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XI-1. General 
 

▣ Use this mode for service engineer. 
 

 

 

Command Function 

General 
 
 

Use to test sample simply for checking the instrument, to set the 
parameters for the measurement and to check the shutter and the 
filter. This mode for Service Engineer. 

Lamp & Electrics 
 

Use to check the status of the Lamp and the Electrics (Power, Fan) 
and to control the Lamp ON/OFF. 

Wavelength 
Calibration 

Use to perform a wavelength calibration of the instrument using 
standard samples.  

Recalibration 
 

Use to perform a wavelength calibration of the instrument using D2 
Peaks. 

ARS Calibration 
 

Use to calibrate the cell position of the Water Jacketed Automatic 
Referencing Stage. This option only appears, if an ARS accessory is 
recognized by the instrument. 

Multicell 
Calibration 
 
 

Used to calibrate the cell position of the 8 Cell Water Jacketed Cell 
Changer. This option only appears if an 8 Multi-Cell accessory is 
recognized by the instrument mode appears. 

Read Diag 
 

Use to open the result file measured using Simple or Advanced 
Diagnostic. 
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XI-2. Lamp & Electronics 
 

▣ Use this mode to check and control the status of the lamps and electrics, power and fan. 

 
1. Select Lamps & Electronics in the System Monitoring. Then following dialog box is 

displayed. 

 

a. Lamp Status: Use to verify the ON/OFF status of the lamps. 

b. Lamp Control: Use to control ON/OFF status of the lamps. 

c. Lamp Monitoring:  

• Lamp Time: Use to check the time used. 

• Lamp Power: Use to check status of lamp’s power. 

d. Power / Fan Speed Monitoring: Use to check the power status and fan speed. 

e. Update Status: Use to update the status of the displayed window after modifying the  

current status of the instrument. 

 

XI-2-1. Lamp Status 
 

Use to check the ON/OFF status of lamps. When lamp is turned on, the circle appears yellow. 

When it is turned off the circle appears white. 

 
Example 1: Both lamps are turned on. 
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Example 2: Only the VIS (tungsten) lamp is turned on.  

 
 

XI-2-2. Lamp Control 
 

Use to control the ON/OFF status of the lamps. 

 
1. Select On in the Deuterium Lamp Control to turn on the Deuterium(UV) lamp. The user 

must wait until the process of updating the status is completed and disappears. 

 
2. Select OFF in the Deuterium Lamp Control to turn it off. 

 
 

3. Select ON in the Tungsten Lamp Control to turn on the Tungsten (VIS) lamp. 

 
4. Select OFF in Tungsten Lamp Control to turn it off. 

 
 

XI-2-3. Lamp Monitoring 
 

Use to check the lamp power and time used. 

 
1. Lamp Time: View the exhausted time of lamp. Select Clear to reset the time count only 

when installing a new lamp. 
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Lamp Life Time 

• Deuterium lamp: 2,000 hours 

• Tungsten lamp: 10,000 hours 

2.  Lamp Power: View the power status of each lamp. 

 

 

XI-2-4. Power / Fan Speed Monitoring 
 
View status for the power and the fan speed of the instrument. 
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XI-3. Wavelength Calibration 
 

▣ Use this mode to calibrate the wavelength using a standard sample.  

 
1. Select Wavelength Calibration in the System Monitoring. Then following dialog box will 

be displayed. 

 

a. Calibration Value: Indicate 4 factors for calibration curve. 

b. Measure: Use to measure the blank, absorbance and intensity. 

c. Load/Calibration: Use to retrieve spectra of standard samples stored in a current 

window and to perform calibration progress.  

d. Total Peak No.: Show the total peak numbers of entered values of standard materials. 

 

 

XI-3-1. Wavelength Calibration Procedure  

 

1. Select Wavelength Calibration. The Calibration Standards dialog box is displayed. 

  
2. The “Standard.dat” file, which is stored in the Standard folder as the default, is opened. These 

values correspond to the wavelength positions of the absorbance peaks of the standard 

samples. Check these values for accuracy. Change the values to match those in the calibration 

certificate of the standard samples used, if necessary, and select OK.  
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▶ Holmium: Refers to the Holmium Oxide Solution Standard. Enter the 14 values 

from the certificate of calibration closest to those shown in the default table  

above based on a SBW of 1.5 nm. 

▶ Didymium: Refers to the Didymium Filter Standard. Enter the 4 values from the 

certificate of calibration closest to those shown in the default table above  

based on a SBW of 1.5 nm.  

▶ F1: Refers to the Holmium Oxide Filter Standard. Enter the 5 values from the 

certificate of calibration closest to those shown in the default table above  

based on a SBW of 1.5 nm.  

▶ D2: Refers to the Instrument’s deuterium lamp and is not an external standard. Use the 

default values provided in the table.  

 

3. The following dialog box is displayed. Select OK.  
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4. Remove the sample from the cell holder and select Blank. 

  

 

5. Place standard sample 1 (Holmium oxide solution) in the cell holder and click Absorbance. 
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6. Select Add Sample to save the data from Sample 1 and select 1 for the Sample No.  

 
 

7. Place the Standard Sample 2 (Didymium filter) in the cell holder and click Absorbance. 

 

8. Select Add Sample to save the data for Standard Sample 2 and select 2 for the Sample No.  

 
 

9. Place the Standard Sample 3, F1 (Holmium Oxide) filter in the cell holder and select 

Absorbance. 
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10. Select Add Sample to save the data for Standard Sample 3 and select 3 for the Sample No. 

 

 

11. Remove all samples from the cell holder and click Intensity to measure Standard Sample 4 

(D2 peak). 
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12. Select Add Sample to save the data of Standard Sample 4 and select 4 for the Sample No.  

 

 

13. After measuring and adding all standard samples, click Calibration. 

. 
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14. The following dialog box is displayed. Find the peaks for each standard sample and add them 

in this window. See XI-3-3. Peak finding for more information. 

 

 

15. Select ‘1’ in the [Sample No.]. 

 

16. Find 14 peaks for Standard Sample 1 (Holmium oxide solution) and add them as shown 
below.  
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17. Select ‘2’ in the [Sample No.]. 

 

18. Find 4 peaks for Standard Sample 2 (Didymium filter) and add them as shown below. 

 

 

19. Select ‘3’ in the [Sample No.]. 
 

20. Find 5 peaks for Standard Sample 3 (F1 Filter) and add then as shown below. 
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21. Select ‘4’ in the [Sample No.]. 
 

22. Find 2 peaks for Standard Sample 4 (D2) and add them as shown below. 

 

 

23. Check the numbers of found peaks. If all peaks were founded, verify that the current Peak No. 

is equal to the Total Peak No. 

 

24. Click Calib Proc. . Check the result of the calibration curve and verify that all of the 

data fits in the following Wavelength Error Trend window. If the calibration result is acceptable, 

select OK. If the result is not acceptable (R2 > 0.9999 Error Max. and Min. <±1), repeat the 

calibration procedure. 

. 
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25. Select Save. The below dialog box is displayed. 

 

 

26. Select OK to finish the wavelength calibration. 

 

XI-3-2. File & Edit Menu 

 

After measuring and adding all standard samples, click Calibration. The following dialog box is 

displayed. Peak points can be found and added for each standard sample here. 

 

 
1. Available commands in File menu and their function include: 
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▶ Open: Use the Open command to retrieve data for a standard sample stored in a 

current windows. 

 

▶ Save: Use the Save command to save data in the current window. The save window 

showing the storage position will appear when Save is clicked. 

▶ Save As: Use the Save as command to save data using a new file name. Select the 

folder to save file in. Input the file name, and click Save. 

 

2. Available commands and its functions in Edit menu are as follows. 

 

▶ Copy Cell: Use the Copy Cell command to copy cell. 

▶ Delete Cell: Use the Delete Cell command to delete cell. 

▶ Cut Cell: Use the Cut Cell command to cut cell. 

▶ Paste Cell: Use the Paste Cell command to paste cell. 

▶ Add Row: Use the Add Row command to add row. 

▶ Add Column: Use the Add Column command to add column. 

▶ Delete Row: Use the Delete Row command to delete row. 

▶ Delete Column: Use the Delete Column command to delete column. 
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XI-3-3. Peak Finding 

 

Peak finding is used to manually identify the correct peaks in the reference samples to use for 

wavelength calibration as shown.  

 

▶ Sample No. : The number of samples which was added, and find peak points by  

designating each sample spectrum. 

▶ Find Peak, Add Peak, Delete Peak: Use to find peaks in the spectrum manually.  

Zoon the peak point to find in the spectrum and click Find Peak. The highest peak in the 

area zoomed is found automatically.  Select Add Peak to save the peak.  Select Delete 

Peak to delete it. 

▶ Calib Proc.: Select Calib Proc. after finding a satisfactory peak point for all spectra. 

Wavelength Calibration will be performed and an Error Trend window will appear. 

▶ Save: Click Save to save satisfactory results. 

▶ Mouse Find: Use to find and add peak using mouse dragging. Check Mouse Find and 

designate peak finding area. One peak is found and added automatically in the designated 

area without selecting Find Peak or Add Peak. 

 Peak Finding Procedure 

1. Select the peak finding area. 

Drag the mouse left to right on the main screen as shown below. The original condition 
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can be restored by dragging the mouse right to left while pushing the left mouse button. 

 
 

2. Select Mouse Find. Click and drag the mouse from the upper-left to the lower-right over 

the tip of a peak. A small blue square appears at the peak position identified. 

      

     If it is difficult to find the correct peak, unclick Mouse Find, repeat step 1 designating a 

smaller area of the spectrum and try again. 

     If the wrong peak position is identified, unclick Mouse Find and click Delete Peak. The 

last peak position to be identified is deleted. 

▶ Auto Find Peak / Peak No.: Use to find peaks with Auto Find Peak. Designate a peak 

finding area and enter the number of peaks to find. Click the Auto Find Peak. The amount 

of peaks can be found by the order of their value. 
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XI-4. Recalibration 
 

▣ Use to recalibrate the wavelength using D2 peaks. 

 
1. Select Recalibration in the System Monitoring. The below dialog box appears. 

 

▶ Calib. Proc.: Use to progress recalibration. 

▶ Save: Use to save recalibrated result. 
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XI-4-1. Recalibration Procedure 

 

   Use to recalibrate the wavelength using D2 Peak. 

 
   Select Recalibration in the System Monitoring. The below dialog box appears. 

 
 

1. Measure D2 by selecting Calb. Proc.. 

 
2. Remove sample from cell holder and select OK. 

 
3. After measuring D2, the result is displayed in two ways according to average dev. peak value. 
 

a. If the value of ‘Average Dev. Peak’ is more than 0.2 nm: 

      Recalibration is needed because the difference between D2 peak and currently measured 

wavelength is more than 0.2. 

b. If the value of ‘Average Dev. Peak’ is less than 0.2 nm: 

      Recalibration is not needed because the difference between the D2 peak and currently 

measured wavelength is less than 0.2. 
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XI-4-2. In case Recalibration needs 

 

1. To recalibrate, select Yes. 

 

 
2. After recalibration is completed, select OK. 

 
3. Select Save to save the data. 

 

 
4. The following dialog box appears. Select OK. 
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XI-4-3. In case Recalibration is not needed 

 

1. If recalibration is not needed, the following dialog box appears. 

 

 
 

XI-5. Read Diag 
 
▣ Use Read Diag to open result files for Simple or Advanced Diagnostic. 
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XI-5-1. Open the Result of Simple Diagnostics  

 

1. Select Read Diag. The Open Diagnostic Result window is displayed. 

 

2. Select the desired file in the Diag folder and select Open. The selected Simple Diagnostics 

Result window is displayed as shown. 

(Result file measured in the simple diagnostic mode are “*-S.dgs”) 

 
 

 

XI-5-2. Open the Result of Advanced Diagnostics 

 

1. Select Read Diag. Then the Open Diagnostic Result window will be displayed. 
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2. Select the desired file in Diag folder and select Open. The selected Diagnostics Result 

window is displayed as shown. 

(Result file measured in the advanced diagnostic mode are “*-A.dgs”) 
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XI-6. Automatic Referencing Stage Calibration 
 

▣ In this mode, you can calibrate the cell position of the ARS (Water Jacketed Automatic 

Referencing Stage). 

 
1. Select ARS Calibration in the System Monitoring.  

 

▶ Reset ARS: Use to move to ‘0’ step of ARS position. 

▶ Cell Position: Show the saved steps for each cell position of the ARS. 

▶ ARS Move:  

• Use to move ARS position by clicking  buttons. 

• Use to move ARS position using  buttons by entered step. 

▶ Calibration Parameters:  

• Total Step: Show the total steps(150) of the operating ARS. 

• One Step: Show the unit of the operation of the ARS pulse (usually used as 1 value). 

▶ ARS Calibration: Use to perform ARS Calibration. 

▶ Stop: Use to stop ARS Calibration. 

▶ Save Result: Use to save calibrated result. 

 

 



 
 

140  UV Lab’s Software User Guide                                         PerkinElmer 

XI-6-1. ARS Calibration Procedure 

 

1. Select Reset ARS to format the ARS. 

 
2. Select ARS Calibration as shown below. Default Value: 150 (Total Step), 1 (One Step) 

 

 
3. Remove all samples from ARS and select OK. 

 
4. Then ARS calibration will start. The current process of calibration is shown. 

     
 

5. When calibration is finished, select OK. 

6. Select Save Result  to save data. Then select OK. 
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XI-7. Multi-Cell Holder Calibration 
 

▣ Use to calibrate the cell position of the 8 Cell Water Jacketed Cell Changer. 

 

1. Select Multicell Calibration in the System Monitoring. The following dialog box is displayed. 

 

▶ Reset Multicell: Use for formatting the Cell holder. 

▶ Cell Position: Show the saved data for each cell position of the Cell holder. 

▶ Multicell Move:  

• Use to move Cell position by clicking  buttons. 

• Use to move Cell position using  buttons by the entered step. 

▶ Calibration Parameters:  

• Total Step: Show the limitation of operation of the Cell holder pulse. Usually you can  

use the set value as a default (590). 

• One Step: Show the units of the operation of the Cell holder pulse. (usually used as 1  

value). 

▶ Multicell Calibration: Use to find each position of the Cell holder. 

▶ Stop: Use to stop Cell holder Calibration. 

▶ Save Result: Use to save the data after Cell holder Calibration. 
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XI-7-1. Multicell Calibration Procedure 

 

1. Select Reset Multicell to format the 8 Cell Water Jacketed Cell Changer. 

 
2. Enter the value in Calibration Parameters. 

 
3. Select Multicell Calibration. Remove all samples from Cell holder and select OK. 

 
4. The Cell holder Calibration will start. The current process of calibration is shown. 

 

 
5. When calibration is finished, click OK. 

 

6. Select Save Result  to save data. 
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